Summer 2019

Relate Promotion Tool

David Nutt
dcn18@zips.uakron.edu

Please take a moment to share how this work helps you through this survey. Your feedback will be important as we plan further development of our repository.

Follow this and additional works at: https://ideaexchange.uakron.edu/honors_research_projects

Part of the Databases and Information Systems Commons

Recommended Citation
https://ideaexchange.uakron.edu/honors_research_projects/844

This Honors Research Project is brought to you for free and open access by The Dr. Gary B. and Pamela S. Williams Honors College at IdeaExchange@UAkron, the institutional repository of The University of Akron in Akron, Ohio, USA. It has been accepted for inclusion in Williams Honors College, Honors Research Projects by an authorized administrator of IdeaExchange@UAkron. For more information, please contact mjon@uakron.edu, uapress@uakron.edu.
Relate Promotion Tool

2440:452 SENIOR CIS PROJECTS
SPRING 2019
# Table of Contents

Introduction to the Problem........................................................................................................... 3  
Goals and Purpose ........................................................................................................................... 3  
Significance .................................................................................................................................... 4  
Intended Solution ............................................................................................................................ 4  
Project Timeline .............................................................................................................................. 4  
Ordered Objectives ......................................................................................................................... 5  
Analysis .......................................................................................................................................... 7  
System Requirements ..................................................................................................................... 7  
Use Case Table ............................................................................................................................... 8  
Use Case Diagrams ......................................................................................................................... 9  
Use Case Descriptions .................................................................................................................... 12  
Things Tables .................................................................................................................................. 18  
Events System Responds To ........................................................................................................... 19  
Domain Model Class Diagram ........................................................................................................ 19  
State Machine Diagrams ............................................................................................................... 20  
Activity Diagrams ......................................................................................................................... 21  
System Sequence Diagrams .......................................................................................................... 27  
Design........................................................................................................................................... 33  
System Controls and Security Design............................................................................................ 33  
The User Interfaces Design ............................................................................................................. 33  
Physical ERD .................................................................................................................................. 36  
Design Class Diagram ................................................................................................................... 37  
Use Case Realization ..................................................................................................................... 37  
Documentation of Interface .......................................................................................................... 43  
Interface at Design Time ............................................................................................................... 43  
Documentation of the Database ..................................................................................................... 45  
Schema of the Tables ...................................................................................................................... 45  
Design for any Screens, Queries, Forms, Reports, and Programs .................................................. 46  
Printout of Structure and Contents of Database Files .................................................................... 46  
Test Data ....................................................................................................................................... 47  
Invalid Data ................................................................................................................................... 47  
Valid Data....................................................................................................................................... 48
Results........................................................................................................................................49
  Interface at Runtime ..................................................................................................................49
  Examples of All Outputs .............................................................................................................51
  All Error Messages the Program Generates ...............................................................................54
Conclusion ....................................................................................................................................56
Bibliography ..................................................................................................................................58
User’s Manual ...............................................................................................................................59
  Importing a Database .................................................................................................................59
  Viewing Inventory Items ............................................................................................................60
  Selecting Inventory Items ..........................................................................................................62
  Searching for Inventory Objects ................................................................................................63
  Exporting Selections .....................................................................................................................64
Introduction to the Problem

Goals and Purpose
Company X is a systems integrator for a point-of-service framework called Xstore offered by Oracle. Clients use a program included with Xstore called Relate to create sales, deals, and coupons. When selecting an inventory object in Relate, the user must enter the object’s ID in a search field and select objects from the results list individually. If a user desires to select an object but omit a specific child object from a promotion they must instead enter all child object codes individually. This process is slow and requires the user to know the ID of whatever object(s) they wish to select. What is to be personally gained from the project is as follows: a greater familiarity with the practicalities of software development, a deeper understanding of the C# environment, and further experience with object-oriented design.

System Capabilities
The user must be able to:

- Import inventory information from a SQLServer database
- Display inventory information in a manner that is easily navigated
- View information relating to an inventory object
- Easily select and omit inventory objects
- Export selected inventory objects in comma separated value (CSV) format in such a way that minimizes values in the exported file
- Search for inventory objects based on ID and filter based on categorization (Department, Subdepartment, Category, Subcategory, Style, and Item)

Business Benefits
The program would:

- Allow clients to use Relate without extensive knowledge of inventory IDs
- Expedite client promotion implementation
- Provide clients with a unique benefit by choosing Company X
Significance
This project demonstrates a practical solution to a real-world problem, executed at a level of quality that is thorough and to be expected in a business environment.

Intended Solution
A standalone application which will allow the user to enter Relate database information and then view the inventory contents of that database in an easily navigable tree. The tree will contain all inventory objects as a child of their respective parent object. By request, the tree nodes will display the objects’ inventory ID and have a hover over label that will display their description. Every tree node will also contain a checkbox, that when checked will enable all descendants and when unchecked disable all descendants and ancestors. When a tree node is highlighted (or ‘clicked’) by the user, the information of the object that node represents will display in a panel to the right of the tree. The user may search inventory objects by ID and filter by categorization. Once the user has selected and omitted all the desired inventory objects they may then export their selections to a comma separated value (CSV) file which will contain the highest level selected inventory object(s), as to minimize values in the CSV file, in the correct format for Relate to import.

Project Timeline

<table>
<thead>
<tr>
<th>ID</th>
<th>Task Name</th>
<th>Start</th>
<th>Finish</th>
<th>Duration</th>
<th>Jan 2019</th>
<th>Feb 2019</th>
<th>Mar 2019</th>
<th>Apr 2019</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Requirement Analysis</td>
<td>1/14/2019</td>
<td>1/24/2019</td>
<td>10d</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Analysis</td>
<td>1/24/2019</td>
<td>2/18/2019</td>
<td>16d</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Design</td>
<td>2/18/2019</td>
<td>3/4/2019</td>
<td>11d</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Testing</td>
<td>4/1/2019</td>
<td>4/22/2019</td>
<td>16d</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Ordered Objectives

1) A user must be able to import a Relate database.

The user must be able to begin the import process and enter the required information for a particular database. The required information is as follows: host IP address and port, database name, username, password, organization ID. The data is then converted to objects and stored in a tree.

2) A user must be able to view the objects in an imported Relate database in an easily navigable manner.

The object information should be displayed in a tree, with the hierarchies from the database preserved as nodes and items as leaves. Due to the possible length of object descriptions, the tree should display the object codes with a hover over display for the description and the tree panel should be resizable. When selected, the properties of an object should be displayed in an object properties panel. The properties are as follows: level code (one of the five user-set codes or item), ID, number of children (blank for items), and description. The level codes are customizable and must be imported from the Relate database.

3) A user must be able to select and omit objects in an imported Relate database in a quick and intuitive way.

The object information displayed in the tree detailed above should include checkboxes. When toggled an object is included in exports, otherwise it is omitted.

4) A user must be able to export the selected objects in an imported Relate database in comma separated value format and minimize entries in the export.

The user must be able to select an export option and select a name and destination for the exported CSV file. To ensure that entries are minimized, when a node is toggled in the tree all child nodes should be toggled. When a node or item is omitted all direct parent nodes should be omitted as well; however, all other child objects of said parents should remain in their previous toggle state. The CSV file will contain all toggled objects at the highest possible level of the hierarchy. This will be done recursively starting at the root node. If a node is toggled it will be added to the CVS file and the next node will be checked, if a node is not toggled all its child
objects will be checked similarly. The format for a CSV entry is as follows: "_levelCode_,
hierarchy_ID,,," (no quotes).

5) A user must be able to search for objects and view their parent and child objects.

The user must be able to enter an object’s ID and select a filter (one of the 5 level codes or item) to view a tree containing only the object with the specified ID, that object's parents, and that object's children. This tree must function similarly to the tree containing all objects (i.e. selecting an object would display that object’s properties, objects must be able to be toggled) and all objects displayed in the search tree must have consistent toggle states with their respective objects in the main tree.
## Analysis

### System Requirements

<table>
<thead>
<tr>
<th>FURPS Category</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| **Functionality** | - Import inventory objects from database  
- Select and omit inventory objects  
- View inventory object information  
- Export selected inventory objects to CSV file |
| **Usability** | - Display inventory objects in tree  
- Display inventory objects' descriptions as hover over  
- Checking an inventory item checks all descendants  
- Unchecking an inventory item unchecks all descendants and ancestors  
- Searching via inventory ID and filter based on category |
| **Reliability** | - Display error message on inability to locate database server  
- Display error message on inability to locate named database  
- Display error message on inability to locate organization in database  
- Display error message on inability to extract information from database  
- Display error message on failure to enter a required field |
| **Performance** | - None |
| **Security** | - None |
## Use Case Table

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Brief Use Case Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import database</td>
<td>The user may enter database information, the system must import the relevant data from the database, the system must convert the imported data to objects.</td>
</tr>
<tr>
<td>Browse objects</td>
<td>The user must be able to navigate imported objects in a tree structure. The system must store imported objects in a tree according to their hierarchy IDs.</td>
</tr>
<tr>
<td>Select objects</td>
<td>The user may toggle an object’s checkbox. If the user is enabling an object, the system must enable all child objects. If the user is disabling an object, the system must disable all child and parent objects.</td>
</tr>
<tr>
<td>View an object</td>
<td>The user may select an object. The system must display the objects level code, ID, number of children, and description.</td>
</tr>
<tr>
<td>Search for objects</td>
<td>The user may enter an object’s ID and filter and the system must display a tree containing that object, that object’s children, and that object’s ancestors.</td>
</tr>
<tr>
<td>Export CSV file</td>
<td>The user may select a name and destination for the CSV file being exported. The system must create a file in specified location and write all selected objects to that file in the appropriate format.</td>
</tr>
</tbody>
</table>
Use Case Diagrams

Promotions Manager

- Import database
- Browse objects
- Select objects
- View an object
- Search for objects
- Export CSV file
## Use Case Descriptions

<table>
<thead>
<tr>
<th>Use case name:</th>
<th>Import database</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario:</td>
<td>Import a Relate database.</td>
</tr>
<tr>
<td>Triggering event:</td>
<td>Promotions manager wants to import a Relate database.</td>
</tr>
<tr>
<td>Brief description:</td>
<td>The Promotions Manager may enter database information, the system must import the relevant data from the database, the system must convert the imported data to objects.</td>
</tr>
<tr>
<td>Actors:</td>
<td>Promotions Manager.</td>
</tr>
<tr>
<td>Related use cases:</td>
<td>None.</td>
</tr>
<tr>
<td>Stakeholders:</td>
<td>Sales, Marketing.</td>
</tr>
<tr>
<td>Preconditions:</td>
<td>Promotions Manager must enter database information and credentials.</td>
</tr>
<tr>
<td>Postconditions:</td>
<td>Database query results must be converted to Merchandise Hierarchies, Items, and the Hierarchy Level Code List. Hierarchy Tree must be populated with Merchandise Hierarchies and Items. The main screen must be shown.</td>
</tr>
</tbody>
</table>
| Flow of activities: | 1. Promotions Manager clicks the ‘Import Database’ button.  
2. Promotions Manager enters the specified database information and credentials.  
1.1 System displays the ‘Import Database’ dialog.  
2.1 System connects to database.  
2.2 System queries the database.  
2.3 System uses query results to fill the Merchandise Hierarchy Level Code List and create Merchandise Hierarchies and Items.  
2.4 System populates Hierarchy Tree with Merchandise Hierarchies and Items. |
| Exception conditions: | 2.1 Database information is incomplete.  
2.1 Database information is not valid.  
2.1 Database credentials are incorrect. |
<table>
<thead>
<tr>
<th><strong>Use case name:</strong></th>
<th>Browse objects</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scenario:</strong></td>
<td>Browse Merchandise Hierarchies and Items in the Hierarchy Tree.</td>
</tr>
<tr>
<td><strong>Triggering event:</strong></td>
<td>Promotions manager wants to view or select Merchandise Hierarchies and Items in the Hierarchy Tree.</td>
</tr>
<tr>
<td><strong>Brief description:</strong></td>
<td>The Promotions Manager must be able to navigate imported objects in a tree structure. The system must store imported objects in a tree according to their hierarchy IDs.</td>
</tr>
<tr>
<td><strong>Actors:</strong></td>
<td>Promotions Manager.</td>
</tr>
<tr>
<td><strong>Related use cases:</strong></td>
<td>May invoke View an object.</td>
</tr>
<tr>
<td><strong>Stakeholders:</strong></td>
<td>Sales, Marketing.</td>
</tr>
<tr>
<td><strong>Preconditions:</strong></td>
<td>A Relate database must be imported. The Hierarchy Tree must be populated.</td>
</tr>
<tr>
<td><strong>Postconditions:</strong></td>
<td>The Hierarchy Tree is visible and navigable.</td>
</tr>
<tr>
<td><strong>Flow of activities:</strong></td>
<td><strong>Actor</strong></td>
</tr>
<tr>
<td></td>
<td>1. Promotions Manager indicates desire to view the Hierarchy Tree.</td>
</tr>
<tr>
<td><strong>Exception conditions:</strong></td>
<td>None.</td>
</tr>
<tr>
<td><strong>Use case name:</strong></td>
<td>Select objects</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Scenario:</strong></td>
<td>Toggle an object in the Hierarchy Tree.</td>
</tr>
<tr>
<td><strong>Triggering event:</strong></td>
<td>Promotions manager wants to include or omit an object.</td>
</tr>
<tr>
<td><strong>Brief description:</strong></td>
<td>The Promotions Manager may toggle an object’s checkbox. If the Promotions Manager is enabling an object, the system must enable all child objects. If the Promotions Manager is disabling an object, the system must disable all child and parent objects.</td>
</tr>
<tr>
<td><strong>Actors:</strong></td>
<td>Promotions Manager.</td>
</tr>
<tr>
<td><strong>Related use cases:</strong></td>
<td>Invokes <em>Browse objects</em>.</td>
</tr>
<tr>
<td><strong>Stakeholders:</strong></td>
<td>Sales, Marketing.</td>
</tr>
<tr>
<td><strong>Preconditions:</strong></td>
<td>The Hierarchy Tree is visible and navigable.</td>
</tr>
<tr>
<td><strong>Postconditions:</strong></td>
<td>The object’s checkbox is toggled. If the object’s checkbox was enabled, all the object’s children are checked. If the object’s checkbox was disabled, all the object’s children are disabled, and all the object’s ancestors are disabled.</td>
</tr>
<tr>
<td><strong>Flow of activities:</strong></td>
<td><strong>Actor</strong></td>
</tr>
<tr>
<td></td>
<td>1. Promotions Manager toggles an object’s checkbox.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Exception conditions:</strong></td>
<td>None.</td>
</tr>
<tr>
<td>Use case name:</td>
<td>View an object</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Scenario:</td>
<td>Display the attributes of an inventory object.</td>
</tr>
<tr>
<td>Triggering event:</td>
<td>Promotions Manager clicks an object in the Hierarchy Tree.</td>
</tr>
<tr>
<td>Brief description:</td>
<td>The Promotions Manager may highlight an object. The system must display the objects level code, ID, number of children, and description.</td>
</tr>
<tr>
<td>Actors:</td>
<td>Promotions Manager.</td>
</tr>
<tr>
<td>Related use cases:</td>
<td>None.</td>
</tr>
<tr>
<td>Stakeholders:</td>
<td>Sales, Marketing.</td>
</tr>
<tr>
<td>Preconditions:</td>
<td>The Hierarchy Tree is visible and navigable.</td>
</tr>
<tr>
<td>Postconditions:</td>
<td>The desired object’s level code, ID, description, and if a Merchandise Hierarchy, number of children are displayed on the Information Screen.</td>
</tr>
<tr>
<td>Flow of activities:</td>
<td>Actor System</td>
</tr>
<tr>
<td>1. Promotions Manager specifies an object in the Hierarchy Tree.</td>
<td>1.1 System displays the specified object’s level code, ID, description, and if a Merchandise Hierarchy, number of children.</td>
</tr>
<tr>
<td>Exception conditions:</td>
<td>None.</td>
</tr>
<tr>
<td><strong>Use case name:</strong></td>
<td>Search for objects</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>Scenario:</strong></td>
<td>Search for an object with a specific ID.</td>
</tr>
<tr>
<td><strong>Triggering event:</strong></td>
<td>Promotions Manager clicks the Search button.</td>
</tr>
<tr>
<td><strong>Brief description:</strong></td>
<td>The Promotions Manager may enter an object’s ID and filter and the system must display a tree containing that object, that object’s children, and that object’s ancestors. If no ID is entered, the main Hierarchy Tree is shown.</td>
</tr>
<tr>
<td><strong>Actors:</strong></td>
<td>Promotions Manager.</td>
</tr>
<tr>
<td><strong>Related use cases:</strong></td>
<td>Invokes Select objects.</td>
</tr>
<tr>
<td><strong>Stakeholders:</strong></td>
<td>Sales, Marketing.</td>
</tr>
<tr>
<td><strong>Preconditions:</strong></td>
<td>A Relate database must be imported. The Hierarchy Tree must be populated.</td>
</tr>
<tr>
<td><strong>Postconditions:</strong></td>
<td>The Hierarchy Tree is replaced with a tree containing the object of the specified Merchandise Hierarchy Level Code and Hierarchy ID/Item ID, that object’s children, and that object’s ancestors.</td>
</tr>
</tbody>
</table>
| **Flow of activities:** | 1. Promotions Manager enters the desired object’s ID, specifies a Merchandise Hierarchy Level Code, and clicks the ‘Search’ button.  
1.1 System searches the Hierarchy Tree for an object of the specified ID and Merchandise Hierarchy Level Code.  
1.2 System replaces the Hierarchy Tree with a tree containing the specified object, that object’s children, and that object’s ancestors. |
| **Exception conditions:** | 1.1 If no ID is entered, the main Hierarchy Tree is displayed.  
1.2 If no object is found with the specified ID with the specified Merchandise Hierarchy Level Code, a message is displayed saying ‘No object with the specified ID and Merchandise Hierarchy Level Code found.’ |
<table>
<thead>
<tr>
<th><strong>Use case name:</strong></th>
<th>Export CSV file</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scenario:</strong></td>
<td>Creation of CSV file.</td>
</tr>
<tr>
<td><strong>Triggering event:</strong></td>
<td>Promotions Manager wants to export their selections.</td>
</tr>
<tr>
<td><strong>Brief description:</strong></td>
<td>The Promotions Manager may select a name and destination for the CSV file being exported. The system must create a file in specified location and write all selected objects to that file in the appropriate format (<em>levelCode</em>, hierarchy_ID, , , , ).</td>
</tr>
<tr>
<td><strong>Actors:</strong></td>
<td>Promotions Manager.</td>
</tr>
<tr>
<td><strong>Related use cases:</strong></td>
<td>None.</td>
</tr>
<tr>
<td><strong>Stakeholders:</strong></td>
<td>Sales, Marketing.</td>
</tr>
<tr>
<td><strong>Preconditions:</strong></td>
<td>A Relate database must be imported.</td>
</tr>
<tr>
<td><strong>Postconditions:</strong></td>
<td>A CSV file with the desired name is located at the specified destination and contains an entry for every selected object (the format for entries being: <em>levelCode</em>, hierarchy_ID, , , , ).</td>
</tr>
<tr>
<td><strong>Flow of activities:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Actor</strong></td>
</tr>
<tr>
<td></td>
<td>1. Promotions Manager clicks the ‘Export CSV File’ button.</td>
</tr>
<tr>
<td></td>
<td>2. Promotions Manager enters the desired name, specifies the location, and clicks the ‘OK’ button.</td>
</tr>
<tr>
<td><strong>Exception conditions:</strong></td>
<td>2.1 If there already exists a file in the specified location with the specified name, it must be specified if the export is to overwrite that file or be cancelled.</td>
</tr>
</tbody>
</table>
## Things Tables

<table>
<thead>
<tr>
<th><strong>Thing</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item</strong></td>
<td>An inventory object that is a type of unit of inventory. Can be located in any Merchandise Hierarchy Object.</td>
</tr>
<tr>
<td><strong>Merchandise Hierarchy Object</strong></td>
<td>An inventory object of the merchandise hierarchy.</td>
</tr>
<tr>
<td><strong>Merchandise Hierarchy</strong></td>
<td>The merchandise hierarchy containing all inventory objects and the ordered list of 5 level codes set by the user in Conflate.</td>
</tr>
</tbody>
</table>

### Item

<table>
<thead>
<tr>
<th><strong>All items have these attributes:</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inventory ID</strong></td>
<td>A unique integer used to identify an item.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>A description of what a specific item is.</td>
</tr>
<tr>
<td><strong>Level Code ID</strong></td>
<td>The location of the “Item” level code in the Merchandise Hierarchy Level Code List.</td>
</tr>
</tbody>
</table>

### Merchandise Hierarchy Object

<table>
<thead>
<tr>
<th><strong>All Merchandise Hierarchy Objects have these attributes:</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inventory ID</strong></td>
<td>A unique integer used to identify a Merchandise Hierarchy.</td>
</tr>
<tr>
<td><strong>Parent ID</strong></td>
<td>The hierarchy ID of a Merchandise Hierarchy’s parent.</td>
</tr>
<tr>
<td><strong>Level Code ID</strong></td>
<td>The location of a Merchandise Hierarchy’s level code in the Merchandise Hierarchy Level Code List.</td>
</tr>
<tr>
<td><strong>Display Name</strong></td>
<td>The name of a Merchandise Hierarchy that is displayed to users.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>A description of a Merchandise Hierarchy, typically longer than a display name.</td>
</tr>
<tr>
<td><strong>Number of Children</strong></td>
<td>Stores the number of children this Merchandise Hierarchy has in order to reduce computation.</td>
</tr>
</tbody>
</table>

### Merchandise Hierarchy

<table>
<thead>
<tr>
<th><strong>The Merchandise Hierarchy has these attributes:</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inventory</strong></td>
<td>The collection of all inventory objects.</td>
</tr>
<tr>
<td><strong>Level Code List</strong></td>
<td>The ordered list of level codes as defined by the user in Conflate.</td>
</tr>
</tbody>
</table>
Events System Responds To

- Import database
- View inventory object
- Select/Omit inventory object
- Search for inventory object
- Export selections

Domain Model Class Diagram
State Machine Diagrams

Inventory Object

Merchandise Hierarchy

loadData(connectionString, valid database) / populate Merchandise Hierarchy
Activity Diagrams

Import Database

<table>
<thead>
<tr>
<th>Promotions Manager</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click import</td>
<td>Display import dialog</td>
</tr>
<tr>
<td>Enter information and credentials</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Connect to database</td>
</tr>
<tr>
<td></td>
<td>Query database</td>
</tr>
<tr>
<td></td>
<td>Build objects</td>
</tr>
<tr>
<td></td>
<td>Populate tree</td>
</tr>
</tbody>
</table>


Select objects

<table>
<thead>
<tr>
<th>Promotions Manager</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Hierarchy Tree</td>
<td>Display object attributes</td>
</tr>
<tr>
<td>Click object</td>
<td></td>
</tr>
<tr>
<td>Toggle object checkbox</td>
<td></td>
</tr>
<tr>
<td>Disable</td>
<td>Enable children</td>
</tr>
<tr>
<td>Disable children</td>
<td></td>
</tr>
<tr>
<td>Disable ancestors</td>
<td></td>
</tr>
</tbody>
</table>
Search for objects

Promotions Manager | System
---|---
Enter search criteria | 
Click search | Search Hierarchy Tree
View Hierarchy Tree | Display Results
Click object | Display object attributes
Toggle object checkbox | Enable children

Enable

Disable children

Disable ancestors

Enable

Disable


System Sequence Diagrams

**Import Database**

```
requestDatabase form()
<--- input details
importDatabase('IP address, port, name, username, password, orgID')
<--- hierarchy tree
```

**Browse Objects**

```
loop until user is finished
showObjectInfo(node)
<-- level code, ID, number of children, description
```
Select Objects

loop until user is finished

showObjectInfo(node)

<-- level code, ID, number of children, description -->

alt

[Enabled]

enableNode(node)

[Disabled]

disableNode(node)
View an Object

Promotions Manager

:System

showObjectinfo(node)

<levelCode, ID, numberOfChildren, description>
Search for Objects

Promotions Manager

:System

- searchHierarchyTree(levelCode, ID)
- result hierarchy tree

loop until user is finished

- showObjectInfo(node)
  - level code, ID, number of children, description

--

- enableNode(node)

[Enabled]

- disableNode(node)

[Disabled]
Export CSV File

Promotions Manager

:requestExportForm

<System>

<output details>

<exportSelection(name, destination)>

<csv file>
### Logical ERD

#### Item
- **PK**: Item_ID
- **String**: Description
- **String**: Level_Code_ID

#### Merchandise Hierarchy Object
- **PK**: Item_ID
- **String**: Level_Code_ID
- **String**: Parent_ID
- **String**: Description
- **Int**: Numer Of Children

#### Merchandise Hierarchy
- **String[]**: Level_Code_List
- **List<Object>**: Inventory
Design

System Controls and Security Design
This project is was created to supplement an existing system. The user has no ability to add, remove, or change the data in any way. All queries performed against the database are done solely to retrieve data and are not augmented by user input. The result file, containing the user’s selections, is meant to be fed directly into the Relate program via a previously implemented system that possesses its own controls and security. As a result, this project is does not contain system controls or security design as they are unnecessary.

The User Interfaces Design

*The initial screen displayed on startup.*
The Import screen displayed when the user selects 'Import' under the 'File' menu.

The main screen displayed after an import has been performed.
The main screen showing the contents of the ‘File’ menu, the contents of the search filter, and the hover over for tree objects.
Physical ERD

**Item**
- PK: Item_ID String
- Description String
- Level_Code_ID String

**Merchandise Hierarchy Object**
- PK: Hierarchy_ID String
- Level_Code_ID String
- Parent_ID String
- Description String
- Numer_Of_Children Int

**Merchandise Hierarchy**
- Level_Code_List String[]
- Inventory List<Object>
Design Class Diagram

Use Case Realization

Import database
Browse objects
Select objects
View an object
Search for objects
Export CSV file
Documentation of Interface

Interface at Design Time

Select File -> Import to Begin
Documentation of the Database

Schema of the Tables

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITM_ITEM</td>
<td>ORGANIZATION_ID, ITEM_ID, DESCRIPTION, ITEM_TAX_GROUP_ID, ITM_ITEM_TYPCODE,</td>
</tr>
<tr>
<td></td>
<td>ITEM_DEPT_ID, ITEM_SUB_DEPT_ID, ITEM_CLASS_ID, SUBCLASS_ID, ITEM_STYLE_ID,</td>
</tr>
<tr>
<td></td>
<td>DIMENSION_1, DIMENSION_1_KEY, ITEM_DIMENSION_1_UOM, DIMENSION_2,</td>
</tr>
<tr>
<td></td>
<td>DIMENSION_2_KEY, DIMENSION_3, ITEM_DIMENSION_2_UOM, DIMENSION_4,</td>
</tr>
<tr>
<td></td>
<td>DIMENSION_4_KEY, UNIT_PRICE, VAT_AMT, UNIT_OF_MEASURE_CODE,</td>
</tr>
<tr>
<td></td>
<td>ITEM_DIMENSION_4_UOM, UNIT_COST, LOYALTY_PTS_INELIGIBLE_FLAG, TAX_EXEMPT_CODE,</td>
</tr>
<tr>
<td></td>
<td>COMPARE_AT_PRICE, MSRP, ITEM_URL, DISALLOW_DISCOUNTS_FLAG,</td>
</tr>
<tr>
<td></td>
<td>NO_GIVEAWAYS_FLAG, SERIALIZED_ITEM_FLAG, SEASON_CODE, BRAND_NAME,</td>
</tr>
<tr>
<td></td>
<td>PART_NBR, QTY_SCALE, NON_PHYS_ITEM_FLAG, NON_PHYS_ITEM_TYPCODE,</td>
</tr>
<tr>
<td></td>
<td>MANUFACTURER, CREATE_DATE, VENDOR, ACTIVE_FLAG, CREATE_USER,</td>
</tr>
<tr>
<td></td>
<td>UPDATE_DATE, UPDATE_USER, COLOR, ITEM_IMAGE_URL, INTENDED_INDUSTRY</td>
</tr>
<tr>
<td>ITM_MERCH_HIERARCHY</td>
<td>HIERARCHY_ID, ORGANIZATION_ID, MERCH_HIERARCHY_LEVEL_CODE,</td>
</tr>
<tr>
<td></td>
<td>PARENT_ID, PARENT_MERCH_HIERARCH_LEVEL_CODE, DISPLAY_NAME,</td>
</tr>
<tr>
<td></td>
<td>DESCRIPTION, SORT_ORDER, CREATE_DATE, CREATE_USER,</td>
</tr>
<tr>
<td></td>
<td>UPDATE_DATE, UPDATE_USER</td>
</tr>
<tr>
<td>ITM_MERCH_HIERARCHY_LVL_CODE</td>
<td>ORGANIZATION_ID, MERCH_HIERARCHY_LEVEL_CODE,</td>
</tr>
<tr>
<td></td>
<td>DESCRIPTION, DISPLAY_NAME, SORT_ORDER, CREATE_DATE,</td>
</tr>
<tr>
<td></td>
<td>CREATE_USER, UPDATE_DATE, UPDATE_USER</td>
</tr>
</tbody>
</table>
Design for any Screens, Queries, Forms, Reports, and Programs

None

Printout of Structure and Contents of Database Files

<table>
<thead>
<tr>
<th>Relate</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S:\SQLServer\MSSQL14.MSSQLSERVER\MSSQL\DATA\Relate_3.ldf</td>
</tr>
<tr>
<td></td>
<td>S:\SQLServer\MSSQL14.MSSQLSERVER\MSSQL\DATA\Relate_1.ndf</td>
</tr>
<tr>
<td></td>
<td>S:\SQLServer\MSSQL14.MSSQLSERVER\MSSQL\DATA\Relate_2.ndf</td>
</tr>
</tbody>
</table>
Test Data

Invalid Data

The following data is input for the Import window and is used to test database connectivity and loading data from a database to convert to Inventory Objects. It is in the format (IP Address = “ipData”, Port = “portData”, Database Name = “dbNameData”, Username = “userData”, Password = “pwData”, Organization ID = “orgIdData”) which correlates to the following entry in the Import screen:

1. (IP Address = “thisiswrong”, Port = “1433”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “123”)
   
   Used to test the behavior of a connection string with an incorrect IP address.

2. (IP Address = “localhost”, Port = “thisiswrong”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “123”)
   
   Used to test the behavior of a connection string with an incorrect port.

3. (IP Address = “localhost”, Port = “1433”, Database Name = “thisiswrong”, Username = “”, Password = “”, Organization ID = “123”)
   
   Used to test the behavior of a connection string with an incorrect database name.

   
   Used to test the behavior of a connection string with incorrect credentials.

5. (IP Address = “localhost”, Port = “1433”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “thisiswrong”)


Used to test the behavior of a connection string with a nonexistent organization ID.

6. (IP Address = “”, Port = “1433”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “123”)

(IP Address = “localhost”, Port = “”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “123”)

(IP Address = “localhost”, Port = “1433”, Database Name = “”, Username = “”, Password = “”, Organization ID = “123”)

(IP Address = “localhost”, Port = “1433”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “”)

Used to ensure the program prompts the user to enter mandatory fields.

Valid Data

The following data is input for the Import window and is used to test database connectivity and loading data from a database to convert to Inventory Objects. It is in the format (IP Address = “ipData”, Port = “portData”, Database Name = “dbNameData”, Username = “userData”, Password = “pwData”, Organization ID = “orgIdData”) which correlates to the following entry in the Import screen:

1. (IP Address = “localhost”, Port = “1433”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “123”)

Used to test the behavior of a correct connection string, Inventory Object creation, and tree population.

2. (IP Address = “localhost”, Port = “1433”, Database Name = “relate”, Username = “”, Password = “”, Organization ID = “402”)

Used to test the behavior of a correct connection string, Inventory Object creation, and tree population. NOTE: the 402 organization contains ill-formatted data and data anomalies used to test the reliability of Relate implementations. The program should still perform expectedly despite said errors when organization 402 is imported.

Results

Interface at Runtime

<table>
<thead>
<tr>
<th>Promotion Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
</tr>
</tbody>
</table>

Select File -> Import to Begin
Levelcode:
ID:
Number of Children:
Description:
Examples of All Outputs
The following outputs correlate to the correspondingly numbered test input in the invalid data section:

1.
2. Error Connecting to Database

Problem connecting to relate at localhost:1433
A network-related or instance-specific error occurred while establishing a connection to SQL Server. The server was not found or was not accessible. Verify that the instance name is correct and that SQL Server is configured to allow remote connections. (provider: SQL Network Interfaces, error: 25 - Connection string is not valid)

OK

3. Error Connecting to Database

Problem connecting to thisiswrong at localhost:1433
Cannot open database "thisiswrong" requested by the login. The login failed.
Login failed for user 'DNT\Uffe'.

OK

4. Error Connecting to Database

Problem connecting to relate at localhost:1433
Login failed for user 'thisiswrong'.

OK
The following outputs correlate to the correspondingly numbered test input in the valid data section:

1.
2. All Error Messages the Program Generates

![Promotion Tool](image1)

![Error Connecting to Database](image2)
Error Connecting to Database

Problem connecting to relate at localhost:1433
A network-related or instance-specific error occurred while establishing a connection to SQL Server. The server was not found or was not accessible. Verify that the instance name is correct and that SQL Server is configured to allow remote connections. (provider: SQL Network Interfaces, error: 25 - Connection string is not valid)

OK

Error Connecting to Database

Problem connecting to thisiswrong at localhost:1433
Cannot open database "thisiswrong" requested by the login. The login failed.
Login failed for user 'DNT\Uffe'.

OK

Error Connecting to Database

Problem connecting to relate at localhost:1433
Login failed for user 'thisiswrong'.

OK

Error Locating Organization

Could not locate organization thisiswrong in relate at localhost:1433

OK
Conclusion

In regard to the requirements stated previously, I have succeeded on all accounts. The program allows for much easier browsing and selection of inventory objects, as well as the ability to view a queried object’s position in the merchandise hierarchy in order to view said object’s children and ancestors.

On the topic of problems and/or mistakes encountered during the development of the program, the largest and most time-consuming was the decision to use the Model View View-Model pattern. Initially I had planned on separating the content from the user interface by storing the information queried from the database in a collection and then generating view-model objects based on that collection to populate the UI tree. This was meant to serve as both a learning exercise and good practice; however, it was found to be very poor practice in implementation for reasons that I will elaborate further on. Firstly, due to the large size of the data being imported, the MVVM pattern caused prolonged load times and increased memory usage. Secondly, the MVVM pattern introduced additional complexity to a project that is otherwise fairly straightforward. Based on the subpar performance alone, the inclusion of the MVVM pattern would be an issue worthy of contention if not for the third reason, that is, this implementation of the MVVM pattern did not produce any benefits in this project. This is because it is both impossible for the user to modify any data (except for selection) in both the memory of the program and the imported database and the UI tree is populated through databinding (which implements its own approximation of MVVM).

Regarding what has been learned, it should first be noted that this project has imparted a greater understanding of the software development lifecycle as previous university projects had required limited planning due to their scope and restrictive timeline. This project has been an excellent opportunity to complete all stages of analysis and design as a continuous work on a single project, as well as to follow though the planning with implementation which allows a better understanding of what
aspects of planning are important in relation to actual development tasks. Secondly, the undertaking of this project has granted an opportunity to gather further knowledge of the C# language and the .NET environment. One such example being the use of Windows Presentation Foundation (WPF), which is a modern UI platform that allows separation of UX from code and can be used in any desktop application. Another example of a practical piece of knowledge that was acquired as part of the development of this project is how to connect and perform queries against a database in C#, which is an absolutely necessary skill in business environments.

Lastly, in reference to future work and extensions for the application, if a feature is requested by a user and is within scope, for example additional inventory object information or a different way to filter a search, I would be happy to implement it.
Bibliography

User’s Manual

Importing a Database

The user may begin the import process by clicking the Import button under the File menu found in the upper right-hand corner of the application (Figure 1).

![Figure 1: the import button](image1)

After clicking the Import button, the user will be prompted with the Import dialog (Figure 2).

![Figure 2: the Import dialog](image2)

The user must enter the following information regarding the SQLServer database they desire to connect to into the specified fields: the database’s IP address in the IP Address field, the database’s port in the Port field (the default port for SQLServer is 1433 is entered automatically), the database’s name in the

Database Name field, and the organization ID of the desired organization in the Organization ID field. Additionally, the user must enter the appropriate username into the Username field and the respective password into the Password field. If the database the user desires to import uses integrated security, the user must leave the Username and Password fields blank. To begin the import, the user must then click the Import button on the Import dialog (Figure 2). To cancel the import, the user must click the Cancel button on the Import dialog.

Viewing Inventory Items
After completing the import process, the user is shown the Main screen (Figure 3).

![Figure 3: the Main screen](image)

The Main screen is divided in to three sections: The Inventory Tree, the Object Panel, and the Search Bar. These are delineated in Figure 4.
To view an inventory object’s properties, the user must highlight the inventory object in the Inventory Tree by clicking on the inventory object’s ID. The highlighted inventory object’s properties will be displayed in the Object Panel (Figure 5).
To view an inventory object’s child objects, the user must click the caret adjacent to the inventory object’s ID in the **Inventory Tree** (Figure 6).

![Inventory Tree with a caret](image)

*Figure 6: an inventory object’s children and its caret*

To view an inventory object’s description without highlighting it, the user must hover the mouse cursor over the inventory object’s ID in the **Inventory Tree** (Figure 7).

![Inventory Tree with a non-highlighted description](image)

*Figure 7: an inventory object’s description as displayed when the cursor is hovering over it (mouse cursor not shown)*

**Selecting Inventory Items**

To select an inventory object, the user must click the checkbox adjacent to the desired inventory object’s ID (Figure 8) in the **Inventory Tree** on the Main screen (Figure 4).

![Inventory Tree with a selected item](image)

*Figure 8: an inventory object’s checkbox*

NOTE: Selecting an inventory object will select all that object’s children (Figure 9).
Deselecting an inventory object will deselect all that object’s children and that object’s ancestors (Figure 10).

Searching for Inventory Objects

The user may search for an inventory object with a specific ID by using the Search Bar (Figure 9). To search for an inventory object, the user must enter the desired inventory object’s ID into the center field and select the desired category from the dropdown located to the left of the center field. Once the user has entered an ID and selected a category, they must click the Search button.

The results of a search will be shown in the Inventory Tree and will contain the object with a matching ID and category, that object’s children, and that object’s ancestors (Figure 12).
To view the Inventory Tree in its entirety after performing a search, the user must clear the center text field in the **Search Bar** and select the **Search** button.

**Exporting Selections**

To export the selections a user has made, the user must click the **Export** button under the **File** menu found in the upper right-hand corner of the application (Figure 13).
After clicking the **Export** button, the user will be prompted with the **Export** dialog (Figure 14).

**Figure 13: the Export button**

After clicking the **Export** button, the user will be prompted with the **Export** dialog (Figure 14).

**Figure 14: the Export dialog**
The user must enter a file name in the **File Name** field and select a location in their file system. When the user has entered a file name and selected a location, they must click the **Save** button to finish the export process.